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Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.

To get maximum versatility from this machine, all operators are requested to read this manual carefully

and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-

able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-

ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the

United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Macintosh, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter are registered trademarks of Apple

Computer, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their

respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Advanced Server

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:

Microsoft® Windows® XP Professional

Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:

Microsoft® Windows ServerTM 2003 Standard Edition

Microsoft® Windows ServerTM 2003 Enterprise Edition

• The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.
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1. Windows Configuration

Using the SmartDeviceMonitor for Client Port

Installing SmartDeviceMonitor for Client

Important

❒ To install SmartDeviceMonitor for Client under Windows 2000/XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [I accept the agreement], and
then click [Next >]

FFFF The SmartDeviceMonitor for Client installer starts.

GGGG Click the [SmartDeviceMonitor for Client] checkbox, and then click [Next >].

The SmartDeviceMonitor for Client installer starts.

HHHH Follow the instructions on the display to install SmartDeviceMonitor for
Client. 

IIII Click [Finish].

If you are required to restart the computer after installing SmartDeviceMon-
itor for Client, restart the computer.

Note

❒ To stop installation of the selected software, click [Cancel] before installa-
tion is complete. Restart the computer and reinstall other programs or
printer drivers.
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Installing the PostScript 3 Printer Driver (Windows 95/98/Me - TCP/IP)

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH In the [Available ports:] box, click [Printer Port], and then click [Next].

IIII Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default. 

JJJJ Specify whether or not to print a test page, and then click [Finish].

KKKK On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

LLLL Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

MMMM On the [Details] tab, click [Add Port…].

NNNN Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

OOOO Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.
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PPPP Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used. 

QQQQ Click [OK].

RRRR Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

SSSS Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me - NetBEUI)

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH In the [Available ports:] box, click [Printer Port], and then click [Next].
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IIII Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default. 

JJJJ Specify whether or not to print a test page, and then click [Finish].

KKKK On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

LLLL Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

MMMM On the [Details] tab, click [Add Port…].

NNNN Click [Other] in the [SmartDeviceMonitor] list, and then click [OK].

OOOO Click [NetBEUI], and then click [Search].

A list of printers using [NetBEUI] appears.

PPPP Click the machine you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the NetBEUI
address. The NetBEUI address can be checked with the configuration page.
For information about printing a configuration page, see p.1 “”. The NetBEUI
address appears in the format of “\\RNPxxxx\xxx” on the configuration
page. Enter the machine's network path in the format of "%%Computer
name\Share name". Use “\\” instead of “%%” at the beginning.

You cannot print using printers beyond routers.

QQQQ Click [OK].

RRRR Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

SSSS Restart the computer to complete installation.

Note

❒ A User Code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 95/98/Me - IPP)

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH In the [Available ports:] box, click [Printer Port], and then click [Next].

IIII Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default. 

JJJJ Specify whether or not to print a test page, and then click [Finish].

KKKK On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

LLLL Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

MMMM On the [Details] tab, click [Add Port…].

NNNN Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].

OOOO Click [IPP].



Windows Configuration

6

1

PPPP In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL ( a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

QQQQ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

RRRR Click [Detailed Settings] to configure proxy server, IPP user name, and other
settings. Make these settings, and then click [OK].

You can enter "http://printer's address/ipp" as the printer's address.

SSSS Click [OK].

TTTT Check that the selected port is highlighted in [Print to the following port], and
then click [OK] .

UUUU Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].
The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [SmartDeviceMonitor], and then click [Next >].

IIII Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

JJJJ Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

KKKK Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

LLLL Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

MMMM Click [Next >].

NNNN Specify whether or not to print a test page, and then click [Next>].

OOOO Click [Finish].
The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - NetBEUI)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [SmartDeviceMonitor], and then click [Next >].

IIII Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.

JJJJ Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the NetBEUI
address. The NetBEUI address can be checked with the configuration page.
For information about printing a configuration page, see p.1 “”. The NetBEUI
address appears in the format of “\\RNPxxxx\xxx” on the configuration
page. Enter the machine's network path in the format of "%%Computer
name\Share name". Use“%%” instead of “\\” at the beginning.

You cannot print using printers beyond routers.

KKKK Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

LLLL Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.
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MMMM Click [Next >].

NNNN Specify whether or not to print a test page, and then click [Next>].

OOOO Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [SmartDeviceMonitor], and then click [Next >].

IIII Click [IPP].
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JJJJ In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

KKKK Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

LLLL Click [Detailed Settings] to configure proxy server, the IPP user name and oth-
er settings. Specify the necessary settings, and then click [OK]. 

For information about the settings, see SmartDeviceMonitor for Client Help.

MMMM Click [OK].

NNNN Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

OOOO Change the printer name if you want, and then click [Next >].

PPPP Click [Next >].

QQQQ Specify whether or not to print a test page, and then click [Next>].

RRRR Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - TCP/IP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe”on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [SmartDeviceMonitor], and then click [Next >].

IIII Click [TCP/IP], and then click [Search].

A list of printers using [TCP/IP] appears.

JJJJ Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

KKKK Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

LLLL Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default. 

MMMM Click [Next >].
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NNNN Specify whether or not to print a test page, and then click [Next>].

OOOO Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003 - IPP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [SmartDeviceMonitor], and then click [Next >].

IIII Click [IPP].
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JJJJ In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

KKKK Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

LLLL Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

MMMM Click [OK].

NNNN Check that the name of the printer driver you want to install is selected, and
then click [Next >].

OOOO Change the name of the printer if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

PPPP Click [Next >].

QQQQ Specify whether or not to print a test page, and then click [Next>].

RRRR Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Add Port:].

GGGG Click [SmartDeviceMonitor], and then click [New Port...].

HHHH Click [TCP/IP], and then click [Search].

A list of printers using [TCP/IP] appears.

IIII Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

JJJJ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

KKKK Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

LLLL Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

MMMM Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.



Using the SmartDeviceMonitor for Client Port

15

1

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - NetBEUI)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Add Port:].

GGGG Click [SmartDeviceMonitor], and then click [New Port...].

HHHH Click [NetBEUI], and then click [Search].

A list of printers using NetBEUI appears.

IIII Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer are displayed.
To use a machine not listed here, click [Specify Address], and then enter the
NetBEUI address. The NetBEUI address can be checked with the configura-
tion page. For information about printing a configuration page, see p.1 “”.
The NetBEUI address appears in the format of “\\RNPxxxx\xxx” on the con-
figuration page. Enter the machine's network path in the format of "%%Com-
puter name\Share name". Use "%%" instead of "\\" at the beginning.

You cannot print using printers beyond routers.

JJJJ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

KKKK Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.
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LLLL Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

MMMM Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Add Port:].

GGGG Click [SmartDeviceMonitor], and then click [New Port...].

HHHH Click [IPP].
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IIII In the [Printer URL] box, enter “http://(printer's address)/printer”as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)

http://192.168.15.16/printer

https://192.168.15.16/printer

You can enter "http://printer's address/ipp" as the printer's address.

JJJJ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

KKKK Click [Detailed Settings] to make necessary settings.

For information about the settings, see SmartDeviceMonitor for Client Help.

LLLL Click [OK].

MMMM Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

NNNN Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

OOOO Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

PPPP Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Note

❒ There are no settings for NetBEUI protocol.

Windows 95/98:

AAAA Open [Printers] window from [Start] menu. .

BBBB  In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties] 

CCCC  Click the [Details] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

AAAA Open [Printers] window from [Start] menu. .

BBBB In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties] 

CCCC On the [Ports] tab, click [Configure Port] 

The [Port Settings] dialog box appears.
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Windows XP, Windows Server 2003: 

AAAA Open the [Printers and Faxes] window from the [Start] menu.

The [Printers and Faxes] window appears.

BBBB Click the icon of the machine you want to use. On the [File] menu, click [Prop-
erties]. The printer properties appear.

CCCC  Click the [Details] tab, and then click [Configure Port].

The [Port Settings] dialog box appears.

• For TCP/IP, timeout setting can be configured.

Note

❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the Smart-
DeviceMonitor for Client icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Par-
allel Printing for each port] check box.

D Click [OK] to close the [Extended Features Settings] dialog box

• User, proxy, and timeout settings can be configured for IPP.

Reference

For information about these settings, see SmartDeviceMonitor for Client
Help.



Windows Configuration

20

1

Using the Standard TCP/IP Port

Installing the PostScript 3 Printer Driver (Windows 2000)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [Standard TCP/IP], and then click [New Port...].

IIII Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

JJJJ Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next>].

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

KKKK Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

LLLL Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

MMMM Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.
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NNNN Click [Next >].

OOOO Specify whether or not to print a test page, and then click [Next>].

PPPP Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [Standard TCP/IP] in [Create a new Port], and then click [Next].

IIII Click [Standard TCP/IP], and then click [OK].

JJJJ Click [Next] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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KKKK Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next>].

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

LLLL Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

MMMM Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

NNNN Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

OOOO Click [Next >].

PPPP Specify whether or not to print a test page, and then click [Next>].

QQQQ Click [Finish].

The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows 2000)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].
The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [LPR Port], and then click [Next >].

IIII Enter the printer's IP address in the [Name or address of server providing lpd] box.

JJJJ Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].

KKKK Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

LLLL Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

MMMM Click [Next >].

NNNN Specify whether or not to print a test page, and then click [Next>].

OOOO Click [Finish].
The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. "If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory."

CCCC Select an interface language, and then click [OK].
The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

EEEE Click [Next >].

FFFF Click [Local Printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH Click [LPR Port] in [Create a new Port], and then click [Next>].

IIII Enter the printer's IP address in the [Name or address of server providing lpd] box.

JJJJ Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].

KKKK Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

LLLL Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

MMMM Click [Next >].

NNNN Specify whether or not to print a test page, and then click [Next>].

OOOO Click [Finish].
The printer driver installation starts.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Add Port:].

GGGG Select [LPR Port], and then click [OK].

HHHH Enter the printer's IP address in the [Name or address of server providing lpd box]
box.

IIII Enter “lp” in the [Name of printer or print queue on that server ] box, and then
click [OK].

JJJJ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

KKKK Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default.

LLLL Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

MMMM Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

Important

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Network Printer], and then click [Next].

GGGG Click [Browse].

HHHH Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

IIII Select the printer you want to use, and then click [OK].

JJJJ Check the location of the selected printer is shown, and then click [Next].

KKKK Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

LLLL Specify whether or not to print a test page, and then click [Finish].

MMMM Restart the computer.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important

❒  Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Network printer], and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the
[Shared printers] window.

IIII Select the printer you want to use, and then click [Next].

JJJJ The printer driver installation starts.

KKKK Click [Next>].

Select the [Yes] check box to configure the printer as default.

LLLL Click [Finish].

Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

❒ If you print with a Windows XP or Windows Server 2003 print server, Smart-
DeviceMonitor notification functions may not be possible for the client.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Network printer] and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the
[Shared printers] window.

IIII Select the printer you want to use, and then click [Next].

JJJJ The printer driver installation starts.

KKKK Click [Next>].

Select the [Yes] check box to configure the printer as default.

LLLL Click [Finish].

Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.



Using as the Windows Network Printer

29

1

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDevice-
Monitor port, the client cannot use Recovery Printing and Parallel Printing.

❒ To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Network printer], and then click [Next].

GGGG Click [Next].

HHHH Double-click the computer name you want to use as a print server in the
[Shared printers] window.

IIII Select the printer you want to use, and then click [Next].

JJJJ Check the location of the selected printer is shown, and then click [Next].

KKKK Change the printer name if you want, and then click [Next].

LLLL Specify whether or not to print a test page, and then click [Finish].

Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server/Remote 
Printer

When using the PostScript 3 Printer Driver

Follow the procedure below to set up the PostScript 3 printer driver.

AAAA In the [Printers] or [Printers and Faxes] window, open the printer properties.

BBBB Click the [PostScript] tab.

Note

❒ When using Windows 2000/XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.

CCCC Click [Advanced].

DDDD Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

EEEE Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Important

❒ Make sure that machine is connected to the computer's USB ports using the
USB interface cable.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

Windows 98 SE/Me - USB

Important

❒ Installation via USB is not possible under Windows 95/98. Upgrade to Win-
dows 98 SE/Me.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

AAAA Turn off the power of the machine.

BBBB Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

CCCC Turn on the power of the machine.

DDDD Click [Next>].

EEEE Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

FFFF Select the [Specify a location:] check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

GGGG Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {{{{Shift}}}} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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HHHH Specify the location where USB Printing Support is located, and then click
[Next>].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:\DRIVERS\RPCS\WIN9X_ME

IIII Check the location, and then click [Next].

USB Printing Support is installed.

JJJJ Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

KKKK Click [Next>].

LLLL Click [Search for the best driver for your device. {Recommended}.], and then click
[Next>].

MMMM Select the [Specify a location:], check box, and then click [Browse...].

The [Browse for Folder] dialog box appears.

NNNN Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {{{{Shift}}}} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

OOOO Specify the location where the source files of the printer driver is stored,
and then click [Next>].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• PostScript 3
D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1

PPPP Check the location, and then click [Next].

Add Printer Wizard starts.

QQQQ Click [Finish].

Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

Note

❒ The number after "USB" varies depending on the number of printers connected.

❒ It is not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

Important

❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

AAAA Turn off the power of the machine.

BBBB Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

CCCC Turn on the power of the machine.

DDDD Click [Next] in the [Found New Hardware Wizard] dialog box.

EEEE Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next].

FFFF Select the [Specify location] check box, and then click [Next].

GGGG Insert the CD-ROM into the CD-ROM drive.

Note

❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the left {{{{Shift}}}} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

HHHH Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

IIII Check the printer driver location, and then click [OK].

JJJJ Click [Next].

KKKK Click [Finish].

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.



Windows Configuration

34

1

Windows XP, Windows Server 2003 - USB

Important

❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

AAAA Turn off the power of the printer.

BBBB Connect the machine with the computer via USB cable.

Connect the USB cable firmly.

CCCC Turn on the power of the machine.

DDDD In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next>].

EEEE To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

Note

❒ If Auto Run starts, click [Cancel], and then [Exit].

FFFF Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

GGGG Check the printer driver location, and then click [Next].

HHHH Click [Continue].

IIII Click [Finish].

If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

Note

❒ The number after “USB” varies depending on the number of printers connected.
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Troubleshooting USB

Problems Solutions

The machine is not automatically recognized. Turn off the power of the machine, reconnect 
the USB cable, and then turn it on again.

Windows has already configured the USB set-
tings.

Open Windows' Device Manager, and then, 
under [Universal Serial Bus controllers], remove 
any conflicting devices. Conflicting devices 
have a yellow [!] or [?] icon by them. Take care 
not to accidentally remove required devices. 
For details, see Windows Help.

Note

❒ When using Windows 2000/XP or Win-
dows Server 2003, an erroneous device is 
displayed under [USB Controller] in the [De-

vice Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PostScript 3 Printer Driver (Windows 95/98/Me)

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH In the [Available ports:] box, click [Printer Port], and then click [Next].

IIII Change the printer name if you want, and then click [Next].

Select the [Yes] check box to configure the printer as default.

JJJJ Specify whether or not to print a test page, and then click [Finish].

KKKK Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH Specify whether or not to print a test page, and then click [Finish].

IIII Select whether or not you want to print a test page, and then click [Finish].

The printer driver installation starts.

JJJJ Restart the computer to complete installation.

Note

❒ A user code user code can be set after the printer driver installation. For in-
formation about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows 
Server 2003)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Click [Local Printer], and then click [Next].

GGGG Select the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

HHHH Select the name of the machine whose driver you want to install, and then
click [Next].

IIII Change the printer name if you want, and then click [Next].

JJJJ Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

KKKK Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

Important

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

AAAA Quit all applications currently running.

BBBB Insert the CD-ROM into the CD-ROM drive.

The installer starts.

Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

CCCC Select an interface language, and then click [OK].

The default interface language is English.

Note

❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next].

FFFF Select the port you want to use, and then click [Next].

A dialog box for selecting the printer manufacturer and model name appears.

GGGG Select the name of the machine whose driver you want to install, and then
click [Next].

HHHH Change the printer name if you want, and then click [Next].

IIII Click [Next].

JJJJ Specify whether or not to print a test page, and then click [Finish].

Set up the options with the printer driver.

KKKK Restart the computer to complete installation.

Note

❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the Printer Driver Using IEEE 1394 
(SCSI print)

The printer drivers can be installed from the CD-ROM provided with this ma-
chine. 

Important

❒ Quit all applications currently running, and do not print during installation.

❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

❒ SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

❒ This machine can receive print data from one computer at a time only. An
message may appear if jobs from different computers collide.

❒ If jobs collide, the first received is printed first.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

Note

❒ If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the "1394_00n" port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

AAAA Connect the machine and computer using the IEEE 1394 interface cable.

BBBB Click [Next] in the [Found New Hardware Wizard] dialog box.

CCCC When the message "This wizard will complete the installation for this De-
vice: Unknown" appears, click [Specify a location], and then click [Next>].

DDDD When the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next>].
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EEEE To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

If Auto Run starts, click [Cancel], and then [Exit].

FFFF Click [Browse].

GGGG Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\

HHHH Click [Open].

IIII Click [OK].

JJJJ Follow the instructions.

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers] window. ("n" shows the number of printers connected.)

Note

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not neces-
sary.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

A When the [Found New Hardware Wizard] dialog box appears, click [Next>].

B When the message "This wizard will complete the installation for this
Device: Unknown" appears, select the [Search for a suitable driver for my de-
vice recommended] check box, and then click [Next>].

C When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

D When the message "Driver Files Search Results" appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish]."



Windows Configuration

42

1

Windows XP, Windows Server 2003

Important

❒ SCSI print must be set to "active" from the control panel. For details, see Net-
work Guide.

❒ Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

Note

❒ This machine can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the com-
puter.

❒ To install another printer driver after setting the "1394_00n" port, click
[1394_00] as a port during the printer driver installation.

❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

AAAA Connect the machine and computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

BBBB Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next>].

CCCC When the message "Please choose your search and installation option." ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

DDDD To disable Auto Run, press the left {{{{SHIFT}}}} key when inserting the CD-
ROM into the drive and keep it pressed until the computer finishes reading
from the CD-ROM.

Note

❒ If Auto Run starts, click [Cancel], and then [Exit].

EEEE Specify the location where the source files of the printer driver is stored,
and then click [Next].

If the CD-ROM drive is D,  the source files of the printer driver are stored in
the following location:

• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\

When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ("n" shows the number of printers connected.)
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FFFF Follow the instructions.

Note

❒ If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

❒ Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.

❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Main-
tenance Guide.

❒ If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below

A When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next>].

B When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next>].

C When the message "The wizard could not find the software on your
computer for.." appears, click [OK].

D When the message "Cannot Install this Hardware" appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth™ Connection

Supported Profiles

❖❖❖❖ SPP, HCRP

• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

• Conditions for bidirectional communications

• SPP connection does not support bidirectional communications.

• HCRP connection supports bidirectional communications.

❖❖❖❖ BIP

• For BIP connection, a module including PostScript 3 must be installed in
the machine.

• Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

• Only JPEG images that can be printed using BIP.

• User codes are disabled for BIP.
You cannot print if print functions are restricted.

• Some printers do not support BIP.

Printing with Bluetooth™ Connection

To install the printer driver, follow the procedure used to install parallel inter-
face.

Important

❒ To install the printer driver under Windows 2000/XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

Note

❒ System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

❒ For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.
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AAAA Start 3Com Bluetooth Connection Manager.

BBBB Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

CCCC On the [Tool] menu, click [COM port].

DDDD Check that the message "Bluetooth Serial Client (COMx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth™.)

EEEE Click [Close].

FFFF On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

GGGG Click the icon of the printer you want to use.

HHHH On the [File] menu, click [Properties].

IIII Click the [Ports] tab.

JJJJ Under [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth™.

KKKK Click [OK].

Close the [Printers] window.

❖❖❖❖ If a dialog box appears while transmitting a print job, reestablish network connec-
tion as follows:

A Select the printer you want to use in the [Printers and Fax] box.

B Click [Connect].

Note

❒ To always use the same printer, select the [Always use for this connection]
check box.

Reference

For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.
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Configuring Security Mode Settings

AAAA Start 3Com Bluetooth Connection Manager.

BBBB On the [Tools] menu, click [Security Mode].

The [Security Mode] dialog box appears.

CCCC Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.46 “Printing in the Security Mode” 

 For all other security modes and custom settings, no password is required.

Note

❒ For information about each mode, see the manuals provided with the utility.

DDDD Click [OK].

Close the [Security Mode] dialog box.

Reference

For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.46 “Printing in the Security Mode”.

Printing in the Security Mode

AAAA Send the print job to the printer in use.

Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

BBBB The [Authentication] dialog box appears.

CCCC Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the ma-
chine. For example, if the serial number is 00A0-001234, the Bluetooth pass-
word is 1234.

DDDD The print job is sent.

Note

❒ The Bluetooth password differs for each machine and cannot be changed.
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If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [>Install Printer].

For Windows 95/98/Me, Windows 2000 and Windows NT 4.0:

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

BBBB Double-click the Add Printer icon.

CCCC Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is either D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1,
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1, or D:\DRIV-
ERS\PS3\NT4\(Language)\DISK1. If the installer starts, click [Cancel] to
quit.

For Windows XP Professional and Windows Server 2003:

AAAA On the [Start] menu, click [Printers and Faxes].

BBBB Click [Add a printer].

CCCC Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.

For Windows XP Home Editions:

AAAA On the [Start] menu, click [Control Panel].

BBBB Click [Printers and Other Hardware].

CCCC Click [Printers and Faxes].

DDDD Click [Install Printer].

EEEE Follow the instructions in Add Printer Wizard.

Note

❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driv-
er is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

Reference

For details about making option settings for the printer, see p.69 “Setting Up
Options”.

Set up option settings when bidirectional communications are disabled.

Limitation

❒ Under Windows 2000/XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

DDDD Click the [Accessories] tab.

Note

❒ Under Windows 2000/XP, Windows Server 2003 and Windows NT 4.0,
click the [Device Settings] tab.

EEEE Select options installed from the [Option] area, and then make the necessary
settings.

FFFF Select the total amount of the memory in [Total memory:], when the optional
SDRAM module is added.

GGGG Under [Paper source tray settings], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

HHHH Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Setting Up the Printer Driver

Windows 95/98/Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

Note

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].
The printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

EEEE Click [OK].

Reference

For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

Note

❒ The procedure to open the printer properties dialog box may vary depending on
the application. For details, see the manuals provided with the application you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.
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AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.

Reference

For details, see Printer Driver Help. 

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 
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Making printer default settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA  On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC  Make the necessary settings, and then click [Print] to start printing.

Reference

For details, see Printer Driver Help. 



Windows Configuration

52

1

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

❒ To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 

Making printer default settings - Printing Preferences

Important

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, click [Printers and Faxes].

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Printing Preferences...].

The [Printing Preferences] dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 
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Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

Note

❒ The procedure to open the [Printing Preferences] dialog box may vary depend-
ing on the application. For details, see the manuals provided with the appli-
cation you use.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA  On the [File] menu, click [Print...].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Select Printer] list.

CCCC  Make the necessary settings, and then click [Print] to start printing.

Reference

For details, see Printer Driver Help. 
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears .

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Properties].

The printer properties dialog box appears.

DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].

Reference

For details, see Printer Driver Help. 

Making printer default settings - Default

Important

❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default. 

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use.

CCCC On the [File] menu, click [Document Defaults].

The [Default] dialog box appears.
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DDDD Make the necessary settings, and then click [OK].

Note

❒ Settings you make here are used as the default settings for all applications.

Reference

For details, see Printer Driver Help. 

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

Note

❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the ap-
plication's own default settings are applied.

❒ Any settings you make in the following procedure are valid for the current
application only.

❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

AAAA On the [File] menu, click [Print].

The [Print] dialog box appears.

BBBB Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.

CCCC Make the necessary settings, and then click [OK].

DDDD Click [OK] to start printing.

Reference

For details, see Printer Driver Help. 
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2. Mac OS Configuration

Mac OS

This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details

Important

❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

Note

❒ The PostScript 3 printer driver is stored in the following folder on the CD-ROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PPD files to print from a Mac OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM drive icon.

CCCC Double-click the [Mac OS 8 and 9] folder.

DDDD Double-click the [PS Driver] folder.

EEEE Double-click the folder of the language you use.

FFFF Open [DISK1], and then double-click the installer icon.

GGGG Follow the instructions on the screen.
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PPD Files

AAAA Double-click the CD-ROM drive icon.

BBBB Double-click the [Mac OS 8 and 9] folder.

CCCC Double-click the [Printer Descriptions] folder.

DDDD Double-click the folder of the language you use.

EEEE Open the [DISK1] folder.

FFFF Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

GGGG Restart the Mac OS.

Setting Up PPD Files

Important

❒ Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

AAAA On the [Apple] menu, click [Chooser].

BBBB Click the Adobe PS icon.

CCCC In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

DDDD Click [Create].

EEEE Click the printer you want to use, and then click [Select].

A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.59 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.
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Creating a Desktop Printer Icon

Important

❒ Make sure that printers are connected to the USB before performing the fol-
lowing procedure.

To use a printer connected by USB, create a desktop printer icon.

AAAA Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

BBBB Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then
click [OK].

CCCC Click [Change] in [USB Printer Selection].

DDDD Select the model you are using in [Select a USB Printer:], and then click [OK].

EEEE Click [Auto Setup] in [PostScriptTM Printer Description (PPD) File].

FFFF Click [Create].

GGGG Enter the printer name, and then click [Save].

The printer icon appears on the desktop.

HHHH Quit Desktop Printer Utility.

Setting Up Options

AAAA On the [Apple] menu, click [Chooser].

BBBB Click the Adobe PS icon.

CCCC In the [Select the PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

DDDD Click [Configure].

A list of options appears.

EEEE Select the option you want to set up, and then select an appropriate setting for it.

FFFF Click [OK].

The list of options closes.

GGGG Click [OK].

The [Chooser] dialog box appears.

HHHH Close the [Chooser] dialog box.

Note

❒ If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.
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Installing the ColorSync Profiles

ColorSync profiles enable a printer to print colors consistent with those on the
computer display. You must install the ColorSync profile to use this function.

Follow the procedure below to install the ColorSync profiles.

AAAA Start a Mac OS.

BBBB Double-click the hard disk icon, and then open the appropriate folder for
installing the ColorSync profiles.

The location of the appropriate folder may vary depending on the version of
the Mac OS. The following are examples:

• System: Preferences: ColorSync profiles

• System: ColorSync profiles

CCCC Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

DDDD Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

EEEE Double-click the [Mac OS 8 and 9] folder.

FFFF Double-click the [ColorSyncTM Profiles] folder.

GGGG Drag the file to the [ColorSyncTM Profiles] folder on the hard disk.

The ColorSync profiles are installed.

Note

❒ The ColorSync profiles are consistent with color characteristics defined by
the International Color Consortium (ICC).

❒ For some computer displays, particular settings need to be created by
ColorSync. For details, see the appropriate manuals for your computer dis-
play.

Installing Adobe Type Manager

Important

❒ Quit all applications currently running before installation. Install ATM after
you restart the computer.

AAAA Start a Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

CCCC Double-click the CD-ROM drive con.

DDDD Double-click the [Mac OS 8 and 9] folder.
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EEEE Double-click the [ATM] folder.

FFFF Double-click the ATM 4.6.3 installer icon.

GGGG Follow the instructions on the screen.

HHHH When the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

IIII On the [Apple] menu, open [Control Panel], and then click [~ATM].

JJJJ The ATM control panel opens.

Note

❒ For details about installation, see the operating instructions in the ATM
folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-
ROM.

AAAA Start a Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM drive icon appears.

CCCC Double-click the CD-ROM drive icon.

The contents of the CD-ROM appear.

DDDD Double-click the [Mac OS 8 and 9] folder.

EEEE Double-click the [Fonts] folder.

FFFF Double-click the [Screen font] folder.

GGGG Double-click the [TrueType] or [Type1] folder.

Select the font type you want to use.

HHHH Copy the fonts you want to install in [Fonts] under [System Folder].

A confirmation message appears.

IIII Click [OK].

The fonts are installed.

JJJJ Restart the Mac OS.
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Using USB Interface

Follow the procedure below to setup USB connection.

AAAA Open the [AdobePS Component] folder on the hard disk.

BBBB Double-click [Desktop Printer Utility].

CCCC Click [AdobePS] in [With:], click [Printer (USB)] in [Create Desktop], and then
click [OK]. 

DDDD Click [Change] in [PostScriptTM Printer Description (PPD) File].

EEEE Select the PPD files of the connected printer, and then click [Select].

FFFF Click [Change] in [USB Printer Selection].

GGGG Select the model you are using in [Select a USB Printer:], and then click [OK].

HHHH Click [Create].

The following message appears.

IIII Specify the file location and the name, and then click [Save].

JJJJ Specify the file location and the name, and then click [Save].

The printer icon appears on the desktop.

KKKK Quit Desktop Printer Utility.

Note

❒ The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Mac OS supports only the standard USB ports for this printer.

❒ When printing with a USB connection to a Macintosh computer, printer
language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.
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Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

AAAA Open [Control Panel], and then double-click the AppleTalk icon.

BBBB On the [Connect via:] pop-up menu, click [Ethernet].

CCCC If you change zones, select a name on the [Current zone:] pop-up menu.

DDDD Close the AppleTalk control panel.

EEEE Restart the computer.

Note

❒ The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP

Reference

For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk, USB and
TCP/IP.

Follow the procedure below to configure Mac OS X 10.1. If you are not using
Mac OS X 10.1, see the manual of the Mac OS X you are using for details.

Important

❒ For Mac OS X 10.1 or higher.

Note

❒ The PPD files are stored in the following folder on the CD-ROM.

Mac OS X:PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

Important

❒ You need an administrator name and a password (phrase). For details, con-
sult your network administrator.

AAAA Insert the CD-ROM into the CD-ROM drive.

BBBB Double-click the CD-ROM drive icon.

CCCC Double-click the [Mac OS X] folder.

DDDD Double-click the installer icon.

EEEE Follow the instructions on the screen.

Setting Up the PPD File

AAAA Start Print Center.

BBBB Click [Add Printer].

Click [AppleTalk] on the first pop-up menu.

If the zone is set, select the zone from the second pop-up menu.

CCCC Select the PPD file for the model you are using from the [Printer Model:] pop-
up menu, and then click [Add].
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Setting Up Options

Important

❒ No printer option settings can be made under Mac OS X. No new settings for
options not installed can be made.

Using USB Interface

Follow the procedure below to setup USB connection.

AAAA Start Print Center.

BBBB Click [Add].

CCCC Click [USB] on the pop-up menu.

The connected printer appears.

DDDD Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.

A list of printer types appears.

EEEE Select the name of the connected printer from the list of printer models, and
then click [Add].

FFFF Close the [Printer List] dialog box, and then quit Print Center.

Note

❒ When printing with a USB connection to a Macintosh computer, printer
language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.
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Using Rendezvous

Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3
or higher. Ethernet, wireless LAN and IEEE 1394 (IP over 1394) connections can
also be used.

AAAA Start Print Center.

BBBB Click [Add].

CCCC Click [Rendezvous] on the pop-up menu.

The connected printer appears.

DDDD Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.

A list of printer types appears.

EEEE Select the name of the connected printer from the list of printer models, and
then click [Add].

FFFF Close the [Printer List] dialog box, and then quit Print Center.

Note

❒ When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

Changing to EtherTalk

Important

❒ You need an administrator name and a password (phrase). For details, con-
sult your network administrator

Follow the procedure below to configure a Mac OS X to use EtherTalk.

Reference

For information about installing applications required for EtherTalk, see the
Mac OS manuals.

AAAA Open [System Preference], and then click the Network icon.

BBBB Click the [AppleTalk] tab.

CCCC Select the [Make AppleTalk Active] check box.

DDDD To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.

EEEE When the settings are made, click [Apple Now].
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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3. Using PostScript 3

Setting Up Options
To use installed options correctly, first set up the printer driver. If the options are
not recognized, you cannot use them, even though they are physically installed.
The procedure to set up a printer driver varies depending on the operating system.

Reference

See p.48 “Making Option Settings for the Printer”, p.59 “Setting Up Options”
or p.65 “Setting Up Options” for the installation method appropriate to your
printing environment.

❖❖❖❖ Windows
You can set up any of the options using the following tabs:

Note

❒ To set up options, access the printer driver from Windows. You cannot set
up options if you access the printer driver from an application.

Limitation

❒ If your system is Windows 2000, Windows XP Professional, or Windows
Server 2003, changing printer driver settings requires Manage Printers
permission. Members of Administrators and Power Users groups have
Manage Printers permission by default. When you change printer driver
settings, log on with an account that has Manage Printers permission.

❒ If your system is Windows NT 4.0, changing printer driver settings re-
quires Full Control access permission. Members of Administrators, Server
Operators, Print Operators, and Power Users groups have Full Control
permission by default. When you change printer driver settings, log on
with an account that has Full Control permission.

❒ If you are using Adobe Page Maker 6.0, 6.5, or 7.0 with Windows
95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0, you have
to set up options in the Adobe PageMaker's print dialog box.

❖❖❖❖ Mac OS
You can set up all options using the [Chooser] dialog box.

Limitation

❒ If you use Mac OS X, this functions cannot be used.

Windows 95/98/Me [Options] on the [Accessories] tab.

Windows 2000/XP, 
Windows Server 2003

[Installable Options] on the [Device Setting] tab.

Windows NT 4.0 [Installable Options] on the [Device Setting] tab in the 
Properties dialog box.

Mac OS For ethernet, [Chooser] on the Apple Menu. For USB, 
[Change Setup] from the [Printing] menu to open the 
Desktop printer.

Mac OS X This function is not available.
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Printing a Document

This documentation describes the specific printer functions and menus that are
added by installing the PPD file. For more information about the functions and
menus of the Windows 95/98/Me PostScript printer driver, see the printer driv-
er's Help.

Preparation

On a Macintosh, Mac OS 8.6 or later (Mac OS X Classic environment is sup-
ported.) or Mac OS X 10.1 or later is required.

Limitation

❒ If you use Mac OS X 10.1.x, the following functions cannot be used:

• Sample Print

• Locked Print

• Document Server

• User Code

Note

❒ If you use Mac OS X 10.2.x or later, Job Type function can use.

❒ “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the
version, [Features x] is displayed as [Set x] (x is a number). Make adjustments
according to the version you use.

Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Normal
Select this for normal printing. The print job starts immediately after the print
command is given.

Note

❒ Under Windows 95/98/Me, if you want to use an User ID, click the [De-
tails...] button.

Windows 95/ 98/ Me [Job Type:] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Job Type:] on the [Job Log] tab in the Printing Preferences 
dialog box.

Windows NT 4.0 [Job Type:] on the [Job Log] tab in the Document Defaults 
dialog box.

Mac OS [Job Type:] on [Job Log] in the print dialog box.

Mac OS X [Job Type:] on [Job Log] in the print dialog box.
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❖❖❖❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the machine. The saved job can be printed from the
machine's control panel. You can also delete the saved job.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the
printer.

❒ Applications with their own drivers, such as PageMaker, do not support
this function.

Note

❒ The “User ID” can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
characters.

❒ Entering the “User ID” helps you to distinguish the print job from others.

Reference

For more information about how to use Sample Print, see p.72 “How to
Use Sample Print”.

❖❖❖❖ Locked Print
Use this function to save documents in the machine memory with a pass-
word, and then edit and print them as you want.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the
printer.

❒ Applications with their own drivers, such as PageMaker, do not support
this function.

Note

❒ The “User ID” can consist of up to eight alphanumeric (a-z, A-Z, 0-9) char-
acters. The “Password” must be 4-8 digits.

Reference

For more information about how to use Locked Print, see p.79 “How to
Use Locked Print”.

❖❖❖❖ Document Server
Use this function to store hard disk documents that you want to print as well
as documents you might want to later combine or process for printing. For
more information about the Document Server function, see "Accessing the
Document Server", Printer Reference.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the
printer.

❒ Applications with their own drivers, such as PageMaker, do not support
this function.
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How to Use Sample Print

Follow the procedure below to print a document using the Sample Print func-
tion.

Windows 95/98/Me

Note

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, sample print jobs are automatically collated by the
printer driver. If the collate option is selected in the application's [Print] dialog
box, more prints than intended may be printed.

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

CCCC Click the [Setup] tab.

DDDD In the [Job Type:] list, click [Sample Print].

EEEE Click [Details...].

FFFF In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters.

Note

❒ This is used to identify the user associated with a job.

GGGG Click [OK].

HHHH Click [OK] to close the printer properties dialog box.

IIII Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.

The sample print job is sent to the machine and one set is printed.

JJJJ Check the printed output to make sure the settings are correct.

If the settings are correct, proceed to step K to print the remaining sets.

If you want to delete a saved job, see p.85 “Deleting a Locked Print File”.

KKKK On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.
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LLLL Press [Locked & Sample Print Job List].

MMMM Press [Sample Print Job List].

A list of the sample print files stored in the machine appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

• Qty. : The number of remaining sets.

NNNN Select the file you want to print by pressing it.

A list of the print files stored in the machine appears.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

OOOO Press [Print] to change the number of sets to be printed.

PPPP Enter the new number of sets using the number keys.

If you do not want to change the set quantity, proceed to step M.

Note

❒ You can enter up to 999 sets.

❒ Press {{{{Clear/Stop}}}} to correct any entry mistakes.
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QQQQ Press [Yes].

The remaining sets are printed.

Note

❒ Press [No] to cancel printing.

❒ When printing is completed, the stored file will be deleted.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.

❒ If there is a print job outstanding, this will be printed before the sample
print job.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

Note

❒ If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, sample print jobs are automatically collated by the
printer driver. If the collate option is selected in the application's [Print] dialog
box, more prints than intended may be printed.

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

Note

❒ Under Windows 2000, select the printer, and then proceed to step C.

❒ Under Windows XP and Windows Server 2003, select the printer, and then
click [Preferences].

CCCC Click the [Job Log] tab.

DDDD In the [Job Type:] list, click [Sample Print].

EEEE In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters.

Note

❒ This is used to identify the user associated with a job.

FFFF Click [OK] to close the printer properties dialog box.

Note

❒ Under Windows 2000, proceed to step G.

GGGG Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.

The sample print job is sent to the machine, and one set is printed.
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HHHH Check the printed output to make sure the settings are correct.

If the settings are correct, proceed to step I to print the remaining sets.

If you want to delete a saved job, see p.85 “Deleting a Locked Print File”.

IIII On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

JJJJ Press [Locked & Sample Print Job List].

KKKK Press [Sample Print Job List].

A list of the sample print files stored in the machine appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

• Qty. : The number of remaining sets.

LLLL Select the file you want to print by pressing it.

A list of the print files stored in the machine appears.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

MMMM Press [Print] to change the number of sets to be printed.

NNNN Enter the new number of sets using the number keys.

If you do not want to change the set quantity, proceed to step M.

Note

❒ You can enter up to 999 sets.

❒ Press {{{{Clear/Stop}}}} to correct any entry mistakes.
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OOOO Press [Yes].

The remaining sets are printed.

Note

❒ Press [No] to cancel printing.

❒ When printing is completed, the stored file will be deleted.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.

❒ If there is a print job outstanding, this will be printed before the sample
print job.

Mac OS/Mac OS X

Limitation

❒ If you use Mac OS X 10.1.x, this function cannot be used.

Note

❒ If you use Mac OS X 10.2.x or later, Job Type function can use.

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Set the number of copies to two or more.

The sample print job is sent to the machine, and one set is printed.

CCCC In the pop-up menu, click [Job Log].

DDDD On the [Job Type:] pop-up menu, select the appropriate setting.

EEEE In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters.

Note

❒ This is used to identify the user associated with a job.

FFFF Check the printed output to make sure the settings are correct.

If the settings are correct, proceed to step G to print the remaining sets.

If you want to delete a saved job, see p.85 “Deleting a Locked Print File”.

GGGG On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.
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HHHH Press [Locked & Sample Print Job List].

IIII Press [Sample Print Job List].

A list of the sample print files stored in the machine appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

• Qty. : The number of remaining sets.

JJJJ Select the file you want to print by pressing it.

A list of the print files stored in the machine appears.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

KKKK Press [Print] to change the number of sets to be printed.

LLLL Enter the new number of sets using the number keys.

If you do not want to change the set quantity, proceed to step M.

Note

❒ You can enter up to 999 sets.

❒ Press {{{{Clear/Stop}}}} to correct any entry mistakes.
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MMMM Press [Yes].

The remaining sets are printed.

Note

❒ Press [No] to cancel printing.

❒ When printing is completed, the stored file will be deleted.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.

❒ If there is a print job outstanding, this will be printed before the sample
print job.

Deleting a Sample Print File

If the printed document is not as you expected, you can delete the sample print
file.

AAAA On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

BBBB Press [Locked & Sample Print Job List].

A list of the print files stored appears.

CCCC Press [Sample Print Job List].

A list of sample print files stored appears.

DDDD Select the file you want to delete by pressing it.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ To cancel a selection, press the highlighted file again.

❒ Only one file can be selected at a time.

EEEE Press [Delete].

A delete confirmation screen appears.

FFFF Press [Yes] to delete the file.

After the file has been deleted the printer screen reappears.

Note

❒ Press [No] to cancel the delete request.
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How to Use Locked Print

Follow the procedure below to print a document using the Locked Print func-
tion.

Windows 95/98/Me

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

CCCC Click the [Setup] tab.

DDDD In the [Job Type:] list, click [Locked Print].

EEEE Click [Details...].

FFFF In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters, and then enter 4-8 digit password in the [Password:]
box.

Note

❒ This is used to identify the user associated with a job.

GGGG Click [OK].

HHHH Click [OK] to close the printer properties dialog box.

IIII After making the necessary settings, click [OK] to close the [Print] dialog box.

The document file is saved in the machine.

If you want to print the document, proceed to step J.

If you want to delete the document, see p.85 “Deleting a Locked Print File”.

JJJJ On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

KKKK Press [Locked & Sample Print Job List].

A list of the print files stored in the machine appears.
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LLLL Press [Locked Print Job List].

A list of stored locked print files appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

MMMM Select the file you want to print by pressing it.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

NNNN Press [Print].

The password screen appears.

OOOO Enter the password using the number keys, and then press [OK].

The print confirmation screen appears.

Note

❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

PPPP Press [Yes].

The locked file is printed.

Note

❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

Note

❒ Under Windows 2000, select the printer, and then proceed to stepC.

❒ Under Windows XP and Windows Server 2003, select the printer, and then
click [Preferences].

CCCC Click the [Job Log] tab.

DDDD In the [Job Type:] list, click [Locked Print].

EEEE In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters, and then enter 4-8 digit password in the [Password:]
box.

Note

❒ This is used to identify the user associated with a job.

FFFF Click [OK] to close the printer properties dialog box.

Note

❒ Under Windows 2000, proceed to step G.

GGGG Start the printing from the application's [Print] dialog box.

The document file is saved in the machine.

If you want to print the document, proceed to step H.

If you want to delete the document, see p.85 “Deleting a Locked Print File”.

HHHH On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

IIII Press [Locked & Sample Print Job List].

A list of the print files stored in the machine appears.
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JJJJ Press [Locked Print Job List].

A list of stored locked print files appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

KKKK Select the file you want to print by pressing it.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

LLLL Press [Print].

The password screen appears.

MMMM Enter the password using the number keys, and then press [OK].

The print confirmation screen appears.

Note

❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

NNNN Press [Yes].

The locked file is printed.

Note

❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.
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Mac OS/Mac OS X

Limitation

❒ If you use Mac OS X 10.1.x, this function cannot be used.

Note

❒ If you use Mac OS X 10.2.x or later, Job Type function can use.

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB In the pop-up menu, click [Job Log].

CCCC On the [Job Type:] pop-up menu, click [Locked Print].

DDDD In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters, and then enter 4-8 digit password in the [Password:]
box.

Note

❒ This is used to identify the user associated with a job.

EEEE After making the necessary settings, click [Print].

The document file is saved in the machine.

If you want to print the document, proceed to step F.

If you want to delete the document, see p.85 “Deleting a Locked Print File”.

FFFF On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

GGGG Press [Locked & Sample Print Job List].

A list of the print files stored in the machine appears.
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HHHH Press [Locked Print Job List].

A list of stored locked print files appears.

The following items also appear:

• User ID:  The user ID set up by the printer driver.

• Date / Time:  The date and time when the job was sent from the computer.

IIII Select the file you want to print by pressing it.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ Only one file can be selected at a time.

JJJJ Press [Print].

The password screen appears.

KKKK Enter the password using the number keys, and then press [OK].

The print confirmation screen appears.

Note

❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

LLLL Press [Yes].

The locked file is printed.

Note

❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. After that, press [Job Reset]. After it has
started, the file will be deleted.
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Deleting a Locked Print File

If the printed document is not as you expected, you can delete the locked print
file.

AAAA On the machine's control panel, press the {{{{Printer}}}} key to display the printer
screen.

BBBB Press [Locked & Sample Print Job List].

A list of the print files stored appears.

CCCC Press [Locked Print Job List].

A list of locked print files stored appears.

DDDD Select the file you want to delete by pressing it.

Note

❒ Press [UUUU Prev.] or [TTTTNext.] to scroll through the list.

❒ To cancel a selection, press the highlighted file again.

❒ Only one file can be selected at a time.

EEEE Press [Delete].

The password screen is appears.

FFFF Enter the password using the number keys, and then press [OK].

A delete confirmation screen appears.

Note

❒ The confirmation screen will reappear if the password was entered incor-
rectly. Press [OK] to enter the password again.

GGGG Press [Yes].

After the file has been deleted, the printer screen reappears.

Note

❒ Press [No] to cancel the delete request.
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How to Use Document Server

Follow the procedure below to print a document using the Document Server
function.

Note

❒ An optional hard disk drive is required to use the Document Server function.

Windows 95/98/Me

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

CCCC Click the [Setup] tab.

DDDD In the [Job Type:] list, click [Document Server].

EEEE Click [Details...].

FFFF Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

GGGG Click [OK].

HHHH Start the printing from the application's [Print] dialog box.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB Select the printer, and then click [Properties].

Note

❒ Under Windows 2000, select the printer, and then proceed to stepC.

❒ Under Windows XP and Windows Server 2003, select the printer, and then
click [Preferences].

CCCC Click the [Job Log] tab.

DDDD In the [Job Type:] list, click [Document Server].

EEEE Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.
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FFFF Click [OK].

Note

❒ Under Windows 2000, proceed to step G.

GGGG Start the printing from the application's [Print] dialog box.

Mac OS/Mac OS X

Limitation

❒ If you use Mac OS X 10.1.x, this function cannot be used.

Note

❒ If you use Mac OS X 10.2.x or later, Job Type function can use.

AAAA From an application, click [Print] on the [File] menu.

The [Print] dialog box appears.

BBBB In the pop-up menu, click [Job Log].

CCCC On the [Job Type:] pop-up menu, click [Document Server].

DDDD Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

EEEE Start the printing from the application's [Print] dialog box.

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about using SmartDeviceMonitor for Admin, see Help.

Windows 95/98/Me [User Code] on the [Statistics] tab.

Windows 2000/XP, 
Windows Server 2003

[User Code:] on the [Job Log] tab in the Printing Preferenc-
es dialog box.

Windows NT 4.0 [User Code:] on the [Job Log] tab in the Document De-
faults dialog box.

Mac OS [User Code:] on [Job Log] in the print dialog box.

Mac OS X [User Code] on [Job Log] in the print dialog box.
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Paper Selection

All Pages and Destination Tabs

Use this to select the media type and input tray.

Limitation

❒ This function is for Windows 95/98/Me only.

Reference

For more information about the [All Pages] and [Destination] tabs. See the print-
er driver's Help.

Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the paper sizes supported by this machine, see
General Setting Guide.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000/XP, 
Windows Server 2003

[Paper Size:] on [Paper/Output] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document De-
faults dialog box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dia-
log box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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Fit to Paper

When the size of the document and paper size differ, set whether or not to print
according to paper size.

❖❖❖❖ Prompt User
Print is performed with the size of document to be printed unchanged.

❖❖❖❖ Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces the
print size.
If the paper size is larger than the size of document to be printed, print is not
to fit the paper size.

❖❖❖❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.

Input Slot

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the paper sources, see Printer Reference.

Windows 95/98/Me [Fit to Print Size:] on the [Paper] tab.

Windows 2000/XP, 
Windows Server 2003

[Fit to Paper] on [Printer Features] on [Document Options] on 
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

Mac OS [Fit to Paper:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Fit to Paper:] on the [Features x] tab on [Printer Features] in 
the print dialog box.

Windows 95/98/Me [Input Tray:] on [All Pages] on the [Paper] tab.

Windows 2000/XP, 
Windows Server 2003

[Paper Source] on the [Paper/Quality] tab in the Printing 
Preferences dialog box.

Windows NT 4.0 The [Page Setup] tab in the Document Defaults dialog 
box.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.
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Resolution

Use this to set the resolution types.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the resolution types, see Printer Reference.

Print Mode (Toner Saving )

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about this function, see Printer Reference.

Windows 95/98/Me [Resolution] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Resolution] on [Graphic] on the [Paper/Quality] or 
[Layout] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Graphic] on [Document Options] on the [Ad-

vanced] tab in the Document Defaults dialog 
box.

Mac OS [Resolution] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Resolution] on the [Features x] tab on [Printer 

Features] in the print dialog box.

Windows 95/98/Me [Toner Saving] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Print Mode:] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Print Mode:] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Print Mode:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Print Mode:] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Duplex Printing

Use this function to select duplex printing.

Limitation

❒ To use this function, the optional duplex unit must be installed on the ma-
chine.

The following table shows the tabs or menus where you can select this function.

You can select the following items: The following items may vary depending on
the operating system you are using.

Windows 95/98/Me

❖❖❖❖ Off
Disables Duplex Printing.

❖❖❖❖ Open to Left
Prints output so that you can open it to the left.

❖❖❖❖ Open to Top
Prints output so that you can open it to the top.

Windows 2000/XP, Windows Server 2003, Mac OS, Mac OS X

Note

❒ If you use a Mac OS, click to select the button that means “Flip on Long Edge”
or “Flip on Short Edge”.

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.

❖❖❖❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.

Windows 95/98/Me [Duplex:] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Print on Both Sides (Duplex)] on the [Layout] tab in the 
Printing Preferences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab 
in the Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The [Print on both Sides] check box on [Duplex:] in the print 
dialog box.
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Windows NT 4.0

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Short Side
Prints output so that you can open it to the short edge when bound along the
short edge.

❖❖❖❖ Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.

Gradation

Use this to select a type of gradation based on your purpose.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the gradation types, see Printer Reference.

Windows 95/98/Me [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Gradation] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in 
the Document Defaults dialog box.

Mac OS [Gradation] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Gradation] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Collate

Use this function to enable collation. With this feature, the machine can efficiently
print collated sets of multiple-page documents.

Limitation

❒ To use this function, a memory unit of at least 192 MB or hard disk drive must
be installed on the machine.

❒ If you use Windows 2000, Windows XP, Mac OS or Mac OS X, make sure that
the following check boxes have not been selected.

• Windows 2000
The [Collate] check box on [Printer Features] on [Advanced...] on the [Paper/
Quality] tab in the Printing Preferences dialog box.

• Windows XP
The [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/ Qual-
ity] tab in the Printing Preferences dialog box.

• Mac OS
The [Collate] check box in the print dialog box.

• Mac OS X
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me The [Setup] tab.

Windows 2000, Windows XP [Collate:] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Collate:] on [Printer Features] on [Document Options] on the 
[Advanced] tab in the Document Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Collate:] on the [Feature 1] tab on [Printer Feature] in the 
printer dialog box.
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Paper Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the media type supported by this machine, see
General Setting Guide.

Destination Tray

The following table shows where you can select this function.

Reference

For more information about the destination tray supported by this machine,
see General Setting Guide.

Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

Windows 2000/XP, 
Windows Server 2003

[Media:] on the [Paper/Quality] tab in the Printing Prefer-
ence dialog box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document De-
faults dialog box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Paper Type] on the [Features x] tab on [Printer Features] in 
the print dialog box.

Windows 95/98/Me [Output Tray:] in [Destination] on the [Paper] tab.

Windows 2000/XP, 
Windows Server 2003

[Destination] in [Printer Features] on [Advanced...] on the [Pa-

per/Quality] or [Layout] tab.

Windows NT 4.0 [Destination] in [Printer Features] on [Document Options] on 
the [Advanced] tab.

Mac OS [Destination] in [Printer Specific Options] in the print dialog 
box.

Mac OS X [Destination]on the [Features x] tab in [Printer Features] in 
the print dialog box.
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Staple

Use this function to staple sheets of printed paper together.

Limitation

❒ When stapling, use the finisher option. See General Setting Guide or Printer Ref-
erence.

Note

❒ The stapling location might differ depending on the orientation of the ma-
chine set in the printer and the orientation of the data to be printed. For de-
tails, see Printer Reference.

The following table shows where you can select this function.

Punch

Use this function to punch holes in the printed documents.

Limitation

❒ When punching holes, use the finisher option. See Printer Reference.

Note

❒ Punch positions and the number of punch holes that are available will change
depending on the type of finisher, the original's orientation, and the printing
paper size and orientation. For details, see Printer Reference.

The following table shows where you can select this function.

Windows 95/98/Me [Staple] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Staple] in [Printer Features] on [Advanced...] on the [Pa-

per/Quality] or [Layout] tab.

Windows NT 4.0 [Staple] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Staple] in [Printer Specific Options] in the print dialog box.

Mac OS X [Staple] on the [Features x] tab in [Printer Features] in the 
print dialog box.

Windows 95/98/Me [Punch] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Punch] in [Printer Features] on [Advanced...] on the [Pa-

per/Quality] or [Layout] tab.

Windows NT 4.0 [Punch] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Punch] in [Printer Specific Options] in the print dialog box.

Mac OS X [Punch] on the [Features x] tab in[Printer Features] in the 
print dialog box.
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Z-fold

Use this function to select the Z-fold type in the printed documents.

Limitation

❒ When Z-fold, use the finisher option. See Printer Reference.

The following table shows where you can select this function.

Watermark

Set the Watermark function.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Watermark Text

Select the Watermark Text type.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Windows 95/98/Me [Z-fold] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Z-fold] in [Printer Features] on [Advanced...] on the [Pa-

per/Quality] or [Layout] tab.

Windows NT 4.0 [Z-fold] in [Printer Features] on [Document Options] on the 
[Advanced] tab.

Mac OS [Z-fold] in [Printer Specific Options] in the print dialog box.

Mac OS X [Z-fold] on the [Features x] tab in[Printer Features] in the 
print dialog box.

Windows 2000/XP, 
Windows Server 2003

[Watermark:] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Watermark:] on [Printer Features] on [Document Options] on 
the [Advanced] tab in the Document Defaults dialog box.

Windows 2000/XP, 
Windows Server 2003

[Watermark Text] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Watermark Text] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog 
box.



Printing a Document

97

3

Watermark Font

Select the Watermark Font type.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Watermark Size

Select the Watermark size.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000/XP, 
Windows Server 2003

[Watermark Font] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Watermark Font] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog 
box.

Windows 2000/XP, 
Windows Server 2003

[Watermark Size] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Watermark Size] on [Printer Features] on [Document Options] 
on the [Advanced] tab in the Document Defaults dialog 
box.
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Watermark Angle

Select the Watermark angle.

Limitation

❒ This item is only for portrait, not for landscape.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Watermark Style

Select the Watermark style.

Note

❒ When using this function under Windows 95/98/Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Win-
dows 2000/XP, Windows Server 2003, and Windows NT 4.0.

Windows 2000/XP, 
Windows Server 2003

[Watermark Angle] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Watermark Angle] on [Printer Features] on [Document Op-

tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Windows 2000/XP, 
Windows Server 2003

[Watermark Style] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Watermark Style] on [Printer Features] on [Document Op-

tions] on the [Advanced] tab in the Document Defaults di-
alog box.
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Color Mode

Use this to select whether the document is printed in color or black and white.

The following table shows the tabs or menus where you can select this function.

Note

❒ If you use Windows 95/98/Me, this mode is called “Color/ Black and White:”.

You can select the following items:

❖❖❖❖ Color
Prints color documents in full color.

Note

❒ Color images will be printed using CMYK toner, Cyan, Magenta, Yellow
and Black. CMYK are three primary subtractive colors.

❒ If you want to adjust the print color, adjust the settings in the Advanced
dialog box accessed from the Advanced button on the [Paper/Quality] tab.

❖❖❖❖ Black and White
Prints everything, including color documents, in black and white. Black and
White printing is faster than Color printing. To stop black and white areas be-
ing printed with CMYK toner, select [Black and White] in the printer driver as
well as in the application.

Windows 95/98/Me [Color/ Black and White:] on the [Setup] tab.

Windows 2000/XP, 
Windows Server 2003

[Color Mode] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

Mac OS [Color Mode] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Color Mode] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Color Setting

Use this to select the correction method used for color conversion.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Color Setting:] in [Ad-
vanced] by selecting [Manual] from the [Color] setting. [Automatic] sets the print-
er to “Super Fine”.

Note

❒ The color rendering dictionary that is selected in the “Color Profile” setting is
used.

You can select the following items:

❖❖❖❖ Off
No modification to the color setting.

❖❖❖❖ Fine
Select this setting to perform color matching based on one of the printer's
built- in color rendering dictionaries and perform CMYK conversion. This
setting performs the printing which output target is Monitor γ = 1.8.

❖❖❖❖ Super Fine
Select this setting to use a color rendering dictionary as in the “Fine” setting but
produce output that is more vivid. Use this setting to emphasize light colors.
This setting performs the printing which output target is Monitor γ = 2.2.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to
color matching, so you should select the appropriate CRD for the document
you are printing. The selected CRD is also referred to when [Fine] or [Super
Fine] is selected for “Color Setting”. The following items are available: [Au-
to],[Photographic], [Presentation] and [Solid Color].

Windows 95/98/Me [Color Setting:] on the [Advanced]window displayed when 
clicking [Advanced...] after selecting [Manual] on [Color] on 
the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Color Setting] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

Mac OS [Color Setting] on [Printer Specific Options] in the print dia-
log box.

Mac OS X [Color Setting] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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Color Profile

Use this to select the color profile pattern.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

Important

❒ If you use Windows 95/98/Me, you can configure [Color Profile:] in [Advanced]
by selecting [Manual] from the[Color] setting. [Automatic] sets the printer to
“Auto”.

❖❖❖❖ Auto
Use this setting to configure the best color profile pattern automatically de-
pending on the appearance of the document to be printed.

❖❖❖❖ Photographic
Use this setting to enhance the reproduction of photos and graphics that in-
clude midtones.

❖❖❖❖ Presentation
Use this setting to enhance the reproduction of documents that contain text
and graphics. This CRD is best for printing colored charts, graphs, presenta-
tion materials and so on. If you use this CRD for printing photographs, the
color or gradations might not be reproduced well.

❖❖❖❖ Solid Color
Use this setting to print specific colors, logos and so on.

❖❖❖❖ User Setting
Use this setting to print images with downloaded CRD from your applica-
tion.

❖❖❖❖ CLP Simulation1
Use this setting to print blue color more brightly and vividly.

Windows 95/98/Me [Color Profile:] in the [Advanced]dialog box displayed 
when you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Color Profile] on [Printer Features] on [Advanced...] on the 
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab 
in the Document Defaults dialog box.

Mac OS [Color Profile] on [Printer Specific Options] in the print dia-
log box.

Mac OS X [Color Profile] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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❖❖❖❖ CLP Simulation2
Use this setting to print blue color more brightly and vividly. Print results are
lighter than those of CLP Simulation1.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to
color matching, so you should select the appropriate CRD for the document
you are printing. The selected CRD is also referred to when [Fine] or [Super
Fine] is selected for “Color Setting”. The following items are available: [Au-
to],[Photographic], [Presentation] and [Solid Color].

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows the tabs or menus where you can select this function.

Gray Reproduction

Use this to select the Black Color mode for text and line art.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Black Over Print] in [Advanced] by selecting [Manual] from 
the [Color] setting.

Windows 2000/XP, 
Windows Server 2003

[Black Over Print] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] 
tab in the Document Defaults dialog box.

Mac OS [Black Over Print] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Black Over Print] on the [Features x] tab on [Printer Features] 
in the print dialog box.

Windows 95/98/Me [Gray Reproduction (Text/Line Art):] in [Advanced] by select-
ing [Manual] from the [Color] setting. [Automatic] sets the 
printer to “Pure Black Text”.

Windows 2000/XP, 
Windows Server 2003

[Gray Reproduction (Text/Line Art)] on [Printer Features] on 
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Gray Reproduction (Text/Line Art)] on [Printer Features] on 
[Document Options] on the [Advanced] tab in the Document 
Defaults dialog box.

Mac OS [Gray Reproduction (Text/Line Art)] on [Printer Specific Op-

tions] in the print dialog box.

Mac OS X [Gray Reproduction (Text/Line Art)] on the [Features x] tab on 
[Printer Features] in the print dialog box.
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You can select the following items:

❖❖❖❖ Black by K
Select this setting to use a black toner.

❖❖❖❖ Black/Gray by K
Black portions are printed in gray.

❖❖❖❖ CMY+K
Select this setting to use all toners.

Dithering

Use this to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Dithering:] in [Advanced] by
selecting [Manual] from [Color] setting. [Automatic] sets the printer to “Auto”.

You can select the following items:

❖❖❖❖ Auto
Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

❖❖❖❖ Photographic
Performs dithering using an appropriate pattern for photographs.

❖❖❖❖ Text
Performs dithering using an appropriate pattern for text.

❖❖❖❖ User Setting
Use this setting to print images set in half tone in your application.

Windows 95/98/Me [Dithering:] in the [Advanced]dialog box displayed when 
you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Dithering:] on [Printer Features] on [Advanced...] on the [Pa-

per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 [Dithering:] on [Document Options] on the [Advanced] tab in 
the Document Defaults dialog box.

Mac OS [Dithering:] on [Printer Specific Options] in the print dialog 
box.

Mac OS X [Dithering:] on the [Features x] tab on [Printer Features] in 
the print dialog box.
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CMYK Simulation Profile

You can simulate the color tone of the printing ink. You can select the printing
ink from US OffsetPrint, Euroscale and JapanColor.

Image Smoothing

Use this to select the image smoothing type.

The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Off
Disables image smoothing.

❖❖❖❖ On
Performs image smoothing unconditionally.

❖❖❖❖ Auto
Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

Windows 95/98/Me [CMYK Simulation Profile:] in the [Advanced]dialog box dis-
played when you click [Advanced...], after selecting [Man-

ual] from [Color] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[CMYK Simulation Profile] on [Printer Features] on [Ad-

vanced...] on the [Paper/Quality] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [CMYK Simulation Profile] on [Document Options] on the [Ad-

vanced] tab in the Document Defaults dialog box.

Mac OS [CMYK Simulation Profile] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [CMYK Simulation Profile] on the [Features x] tab on [Printer 

Features] in the print dialog box.

Windows 95/98/Me [Image Smoothing] in the [Advanced]dialog box displayed 
when you click [Advanced...], after selecting [Manual] from 
[Color] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Image Smoothing] on [Printer Features] on [Advanced...] on 
the [Paper/Quality] tab in the Printing Preferences dialog 
box.

Windows NT 4.0 [Image Smoothing] on [Printer Features] on [Document Op-

tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Image Smoothing] on [Printer Specific Options] in the print 
dialog box.

Mac OS X [Image Smoothing] on the [Features x] tab on [Printer Fea-

tures] in the print dialog box.
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❖❖❖❖ Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

Note

❒ When [Auto] is selected, data processing may take a long time.

❒ When Image Smoothing is used for a mask image, this function may have an
undesired effect on the print result.

Color Control

Use this to select whether or not you want the colors in the documents to be ad-
justed before printing so that the printed page matches closer to the colors on the
screen.

The following table shows the tabs or menus where you can select this function.

Note

❒ If you use Windows 2000/XP or Windows Server 2003, this function is called
“Image Color Management”.

❒ If you use Windows NT 4.0, this function can not be configured.

❒ If you use Mac OS, this function is called “Color Matching”.

❖❖❖❖ Image Color Control
Display the Image Color Matching dialog box, click this button to specify ex-
actly how you want the colors on your screen adjusted before printing.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Graphic] on [Advanced] on the [Paper/Quality] tab in the 
Printing Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Color] on the [Color Matching] tab in the print dialog box.

Mac OS X This function is not available.
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Separate into CMYK

Use this to select the print separation type. You can separate the printing data
into CMYK to specify a specific color combination.

Windows 95/98/Me [Separate into CMYK:] in the [Advanced]dialog box dis-
played when you click [Advanced...], after selecting [Man-

ual] from [Color] on the [Print Quality] tab.

Windows 2000/XP, 
Windows Server 2003

[Separate into CMYK] on [Printer Features] on [Advanced...] 
on the [Paper/Quality] tab in the Printing Preferences dia-
log box.

Windows NT 4.0 [Separate into CMYK] on [Document Options] on the [Ad-

vanced] tab in the Document Defaults dialog box.

Mac OS [Separate into CMYK] on [Printer Specific Options] in the 
print dialog box.

Mac OS X [Separate into CMYK] on the [Features x] tab on [Printer Fea-

tures] in the print dialog box.
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4. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Limitation

❒ If a Macintosh and printer are connected by USB, you cannot use Printer Util-
ity for Mac.

Note

❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers
and Utilities”.

❒ Printer Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic envi-
ronment is supported.)

❒ Printer Utility for Mac cannot use Mac OS X (native mode).

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

AAAA Start the Mac OS.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

CCCC Double-click the icon of hard disk to open it.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [Mac OS] folder.

FFFF Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Print-
er Utility for Mac] file, and then drop it into the Macintosh hard disk.

GGGG Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.

Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Important

❒ Before starting Printer Utility for Mac, confirm that the printer is selected with
[Chooser] on the Apple menu.

AAAA Double-click the Printer Utility for Mac icon.

The Printer Utility for Mac dialog box appears.

BBBB Click [OK].

Printer Utility for Mac will take a few seconds to start.

Reference

For more information, see “Printer Utility for Mac Functions”. 
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu

• [Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.110 “Download-
ing PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See p.111 “Displaying Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.112 “Initializing the Printer
Disk”.

• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.112 “Page Setup”.

• [Print Font Catalog...]
Print the names of available fonts. See p.112 “Printing Font Catalog”.

• [Print Font Sample...]
Print a sample of fonts. See p.113 “Printing Font Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.113 “Renam-
ing the Printer”.

• [Restart Printer]
Restart the printer. See p.114 “Restarting the Printer”.

❖❖❖❖ Utility menu

• [Download PostScript File...]
Download a PostScript File. See p.114 “Downloading PostScript Files”.

• [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.115
“Selecting the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.115 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See
p.116 “Launching the Dialogue Console”.
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Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important

❒ The following procedures to download the fonts assume that you are a system
administrator. If you are not, be sure to consult your system administrator.

❒ If the printer restarts, all the printer settings return to their defaults.

❒ Confirm that a Mac OS and the printer are connected with Appletalk.

Note

❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation about the fonts you want to
use.

AAAA Select [Download PS Fonts...] on the [File] menu.

BBBB Click [Add to list].

The dialog box to select fonts appears.

CCCC Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

DDDD After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

EEEE Click [Download].

The fonts begin to download, and the download status is shown.

Important

❒ During the download, do not turn off the power switch, operate the panel
or open or close the cover.

FFFF When the completion message appears, click [OK].

GGGG Click [Cancel].
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Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.

Note

❒ The fonts displayed in italics are the default fonts.

AAAA Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Click [OK].

Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

AAAA Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Select the fonts you want to delete.

Limitation

❒ You cannot delete the fonts displayed in italic.

DDDD Click [Delete].

A confirmation message appears.

EEEE Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

FFFF Click [Continue], and then click [OK].

GGGG Click [OK].
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Initializing the Printer Disk

When initializing the printer's hard disk drive, all the fonts downloaded to the
printer's hard disk drive are deleted. Before initializing, be sure to check the
fonts on the hard disk drive.

Important

❒ When initializing the printer's hard disk drive from the operation panel, all of
the data on the printer's hard disk drive is deleted. Before initializing, be sure
to check the data on the hard disk drive.

AAAA Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

Note

❒ To cancel initialization, click [Cancel].

BBBB Click [Execute].

Initializing starts.

Important

❒ Do not turn off the power switch until initializing is completed, otherwise
the hard disk drive might be damaged.

CCCC When the completion message appears, click [OK].

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

AAAA Select [Page Setup...] on the [File] menu.

BBBB Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

Note

❒ The paper selected under [Page Setup] is used.

AAAA Select [Print Fonts Catalogue] on the [File] menu.

BBBB Click [Print].



Printer Utility for Mac Functions

113

4

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

Note

❒ Print by using the paper selected on [Page Setup].

AAAA Select [Print Fonts Sample...] on the [File] menu.

BBBB Click [Print].

Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect
several printers on the network, assign different names so you can identify them.
If several printers have the same name, a digit appears next to the printer name
in [Chooser].

AAAA Select [Rename Printer...] on the [File] menu.

BBBB Type a new name in the [New name:] field. 

Limitation

❒ You can enter up to 31 digits and letters.

❒ Do not use symbols, for example “*”, “:”, “=”,”@”, “~”.

CCCC Click [Rename].

The printer name is changed.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Click to select the printer name renamed in step BBBB, and then close [Chooser].

Note

❒ If there are several Appletalk zones, select the zone to which the printer be-
longs to.
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Restarting the Printer

You can restart the printer.

AAAA Select [Restart Printer] on the [File] menu.

BBBB Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note

❒ The fonts that you downloaded in the printer's memory will be deleted.

❒ If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.

AAAA Select [Download PostScript File...] on the [Utility] menu.

BBBB Select the file name to download and click the file name, and then click
[Open].

CCCC Type the log file name, and then click [Save...].

The selected file is downloaded.

Note

❒ Errors are recorded in the log file.
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Selecting the Zone

You can change the zone to which the printer belongs to via Appletalk.

Important

❒ Confirm that the printer and a Mac OS are connected in an Appletalk envi-
ronment.

AAAA Select [Select Zone...] on the [Utility] menu.

The zone to which the printer belongs to and the available zone list appear.

BBBB Select the zone to which you want to switch the printer, and then click
[Change].

A confirmation message appears.

CCCC Click [Continue].

A confirmation message appears.

DDDD Press [OK].

EEEE Select [Chooser] on the Apple menu.

FFFF Click the [AdobePS] icon.

GGGG Select the zone selected in step BBBB on the [Appletalk zone:] list.

HHHH Click to select the printer you want to use on the [Select a PostScript Printer:]
list.

IIII Close [Chooser].

Displaying the Printer Status

You can display and confirm the current status of the printer.

AAAA Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

BBBB Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs to.

CCCC Click [OK].
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Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

Important

❒ “Launch Dialogue Console” is recommended for users with an understand-
ing of PostScript.

❒ Do not download any file other than PostScript files to the printer.

❒ “Launch Dialogue Console” must be used at your own responsibility.

AAAA Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

BBBB Type the PostScript command in the editor screen.

Note

❒ To edit a PostScript file, select [Open] on the [File] menu to open it.

❒ You can search or replace a character string by using the [Search] menu.

CCCC After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.

The PostScript file is sent to the printer.

Note

❒ The [Reply from Printer] box opens, depending on the PostScript file you
sent.

DDDD Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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